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grar todos los recursos utilizados en un œnico
documento. Adem‡s, en muchas ocasiones,
las opciones viables para montar estas piezas
formando un complejo uniforme suponen la
utilizaci—n de herramientas caras, dif’ciles de
utilizar y que, a menudo, crean documentos
cerrados con formatos propietarios. En cual-
quier caso, este modelo continœa otorgando
escasa iniciativa al lector.

¿Qué es Sophie?
Sophie [1] es una herramienta de autor,
basada en Squeak, destinada a la creaci—n de
libros digitales multimedia que permite unir
im‡genes, textos, v’deo, audio y animaciones
en un œnico documento. Es un programa
sencillo de usar que facilita la combinaci—n
de documentos de texto, diapositivas, presen-
taciones, pistas de sonido, archivos de v’deo,
subtitular pel’culas, etc.

No se trata de una herramienta destinada a
generar textos convencionales con el fin de
que sean le’dos en el ordenador, sino que sus
objetivos van m‡s all‡ de la impresi—n, utili-
zando las potencialidades interactivas de los
ordenadores personales, pero dotando al
autor de un control total del continente y el
contenido de lo que hace y favoreciendo la
participaci—n activa del lector.

¿Por qué S ophie?
El objetivo de Sophiees proporcionar una
herramienta que permita la creaci—n de
robustos y elegantes documentos multime-
dia, compartibles a travŽs de la red f‡cil-
mente, y sin que el usuario posea recursos de
programaci—n. La sencillez de uso para per-
sonas sin experiencia es una de las notas de
identidad m‡s importantes de Sophie. En esta
l’nea, el programa utiliza la rutina de arr astrar
y soltar recursos en su documento principal
como forma de integraci—n de los elementos
utilizados. Adem‡s, permite incrustar archi-
vos de audio, v’deo y textos gr‡ficos remotos
en las p‡ginas de sus documentos. Por otra
parte, Sophiepuede navegar a travŽs de los
repositorios (bases de datos) OKI, e incluir
objetos de estos repositorios en sus libros.
Ambas opciones suponen evidentes ventajas.
De este modo, los documentos Sophieque se

Cuando se habla de libros electr—nicos
se piensa inmediatamente en archivos
con formato pdf o bien en textos basa-

dos en p‡ginas web. La raz—n resulta obvia,
los archivos pdf lo inundan todo, tr ansmiten
’ntegramente la informaci—n manteniendo el
aspecto original y favorecen su distribuci—n,
pero resultan escasamente interactivos. Es
cierto que es posible incluir formularios, boto-
nes, enlaces, e incluso archivos de audio y
v’deo en este tipo de archivos, pero los docu-
mentos as’ generados continœan siendo muy
est‡ticos. El procedimiento de elaboraci—n es
semejante al de la impresi—n de un docu-
mento. Una vez dise–ado y transformado en
pdf no hay forma, salvo con software dedi-
cado, de devolver el documento a su formato
original para poder modificarlo. De esta
manera se mantiene el modelo de separaci—n
escritor-lector, en el que el primero es el crea-
dor y el segundo adopta la actitud pasiva de
un simple consumidor de literatura.

El modelo alternativo de publicaciones
electr—nicas se basa en lenguajes especializa-
dos de marcas como HTML y XML. En estos
casos el contenido que se crea resulta m‡s
fluido que con los pdfs, pero requiere que el
usuario utilice y domine v ariadas y, a veces,
complejas herramientas y sea capaz de inte-

Un libro es mucho m‡s que un contenedor de texto presentado de una forma œtil, y Sophie es m‡s que un

mero soporte de archivos multimedia. Sophie representa el tipo de software destinado a revolucionar el con-

cepto de e-book , permitiendo estructurar la informaci—n de una forma f‡cil, atractiva, intuitiva e inteligente.
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Figur a 1: Sophie.
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distribuyan pueden ser ligeros, y se actuali-
zan en tiempo real a medida que cambien los
recursos utilizados, aunque el libro en s’
ocupe bastante espacio.

Sophiepermite enlazar f‡cilmente a Inter-
net, puede utilizar plantillas para sus produc-
tos y proporciona caracter’sticas profesiona-
les de programaci—n. Por otra parte, resulta
f‡cil de distribuir y sus documentos se pue-
den actualizar en un servidor para que pue-
dan circular libremente por la red. Se dispone
tambiŽn de campos din‡micos vivos de texto
similares a los que el Instituto para el Futuro
del Libro [2] experimenta en la web, tales
como que un comentario escrito en el mar-
gen se muestre inmediatamente en cada
copia de ese libro en cualquier parte del
mundo.

Promot ores
El proyectoSophiees una iniciativa del Insti-
tuto para el Futuro del Libro liderada por Bob
Stein, una instituci—n del Centro Annenberg
para la Comunicaci—n de la Universidad del
Sur de Californiacon sede en Brooklyn (New
York). Los principales fondos de Sophiepro-
vienen del Programa de Investigaci—n en Tec-

nolog’a de la Infor-
maci—n de la Fun-
daci—n Andrew
Mellon, recibiendo
apoyo comple-
mentario de la
Escuela de Artes
Cinematogr‡ficas
de la Universidad
del Sur de Califor-
nia.

Adem‡s, en el
proyecto colaboran
equipos de trabajo
como el grupo
Impara [3] en Ale-

mania, que anteriormente hab’a estado des-
arrollando Tweak, otro sabor de Squeak; John
McIntosh y Tim Rowledge en Canad‡ y Astea
en Bulgaria.

Licencia
Sophiees open-source, software de c—digo
abierto distribuido bajo licencia BSD[4] de la
Universidad de Berkeley (Berkeley Software
Distribution), que permite la libr e redistribu-
ci—n y modificaci—n del programa
manteniendo la protecci—n de copy-
right exclusivamente a efectos de
renuncia de garant’as y de requerir
la atribuci—n de autor’a de los traba-
jos derivados.

Ant ecedentes
El nacimiento y desarrollo de
Sophieest‡ fuertemente vinculado a
su l’der y principal pr omotor,
Robert Stein. Bob Stein es el Direc-
tor del Instituto par a el Futuro del
Libro y fundador de la Compa–’a
Voyager. Antes de la Voyager, Stein
trabaj— con Alan Kay en el grupo de
investigaci—n de Atari, en varios
proyectos de publicaci—n electr—-
nica. Posteriormente comenz—
Night Kitchen para desarrollar
herramientas de autor para la
siguiente generaci—n de publicacio-
nes electr—nicas. A comienzos de
1990, y antes de que surgieran los
libros con formatos pdf y html, la
Compa–’a Voyager realiz— los pri-
meros esfuerzos para desarrollar un
entorno multimedia que desem-
boc— en las series de libros expandi-
dos (The Expanded Books) y en la
herramienta integrada Expanded
Book Toolkit, que permit’a a los
usuarios crear sus propios libros.

Este trabajo est‡ siendo continuado en el Ins-
tituto del Futuro del Libro con el proyecto
Sophie.

Proyectos
El primer lanzamiento en fase alpha de
Sophietuvo lugar en el mes de febrero de
2007. Se prevŽ tener disponible una versi—n
m‡s robusta del programa para el mes de
junio y lanzar una v ersi—n especial optimi-
zada para que sea incluida en el lanzamiento
de los primeros seis millones de ordenadores
OLPC[5]. Para septiembre de este a–o se
espera el lanzamiento de la primera versi—n
beta del programa que incluir‡ un lector
independiente. Por œltimo, el lanzamiento de
Sophie 1.0est‡ previsto para finales de a–o.

El Ent orno de T rabajo
En un entorno de trabajo funcional, Sophie
proporciona todas las herramientas que el
usuario puede necesitar para la elaboraci—n
de un libro electr—nico y para interactuar con
Žl. Su interfaz de trabajo consta del espacio
de trabajo central destinado a la elaboraci—n
y acceso a los libros, sendos juegos de pesta-

–as situadas a ambos laterales y la
barra de menœs ubicada en la parte
superior de la pantalla.

Barr as de Menús
La parte superior del interfaz de
Sophieest‡ presidida por una barra
de menœs (Archivo, Editar, Depurar
y Ayuda) que proporciona funcio-
nes importantes para manejar el
programa, aunque el trabajo princi-
pal se realizar‡ mediante las pesta-
–as, tabuladores, paletas, halos y
huds.

Pestañas, Tabulador es y
Paletas
Las pesta–as laterales, tabuladores
y paletas se utilizan para manipular
la mayor parte de las funcionalida-
des de Sophieque no se pueden
obtener mediante halos y huds. El
contenido mostrado por cada una
de las pesta–as laterales se subdi-
vide en tabuladores, y cada tabula-
dor muestra paletas que pueden
redimensionarse arrastrando los
bordes o convertirse en ventanas
flotantes arrastrando su barra de
t’tulos hasta el espacio de trabajo.

Las pesta–as del margen
izquierdo son elementos de dise–o
que se usan para modificar la

Figur a 2: Ent orno de tr abajo.

Figur a 3: Pes-

t añas de

diseño.

Para instalar la versi—n Candidate de
Sophie descargaremos el paquete:

<LI> SophieRC5.zip

(RC5 representa el nœmero de lanza-
miento de la versi—n Sophie Early Rele-
ase Candidate 5 del 10 de abril de 2007)
de la secci—n Descargas (Download) de
la p‡gina oficial del Proyecto Sophie [6].

A continuaci—n descomprimiremos el
archivo comprimido en una carpeta y
lanzaremos el programa haciendo doble
clic sobre el fichero Sophie.sh del direc-
torio recientemente descomprimido.

Instalaci—n en Linux
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estructura del libro. Los tabulado-
res de la pesta–a herramientas
proporcionan diversas opciones
de configuraci—n, la pesta–a
libros muestra los libros abiertos,
la pesta–a p‡ginas presenta
miniaturas de las p‡ginas del
libro actual y la l’nea del tiempo
despliega la herramienta que per-
mite establecer una secuencia-
ci—n en el tiempo de las paginas y
acciones incluidas en el libro.

Por otro lado, las pesta–as del
margen derecho est‡n destinadas
a proporcionar contenido que se
puede utilizar en la elaboraci—n
de los libros. Podemos encontrar
objetos OKI, plantillas, estilos cre-
ados, recursos multimedia impor-
tados a Sophie, componentes que
se pueden arrastrar hasta las p‡gi-
nas de los libros y servidores de
red Sophie.

Halos y HUDs
La interacci—n con los elementos
de Sophie se realiza, como en
Squeak, mediante halos. Todos
los objetos disponen de, al
menos, dos botones que se mues-
tran al hacer clic sobre ellos, y
mediante los cuales podremos
acceder a ventanas emergentes
(HUD, de head-up display) que muestran
diferentes opciones para el objeto seleccio-
nado. Para hacer desaparecer un halo o hud
activos bastar‡ con hacer clic en cualquier
lugar vac’o del espacio de trabajo.

La Líne a de Tiempo
La l’nea de tiempo es una representaci—n
lineal del avance de una animaci—n. Es un
recurso utilizado para establecer una secuen-
ciaci—n de acciones que afectan a los recursos
y p‡ginas del libro. En Sophiehay dos clases
de l’neas de tiempo, la l’nea de tiempo de
p‡gina simple, que contiene œnicamente las
acciones que se usan en esa p‡gina, y la linea
de tiempo de p‡ginas mœltiples, que ejecuta
acciones que afectan a varias p‡ginas en un
determinado tiempo. La l’nea de tiempo de
p‡ginas mœltiples se usa cuando se construye
una presentaci—n en la que las p‡ginas se eje-
cutan con acompa–amiento de audio y
v’deo.

Para crear l’neas de tiempo pulsaremos
sobre la pesta–a timelines situada en el mar-
gen izquierdo y, a continuaci—n, sobre el
signo + que se mostrar‡ en su parte inferior.

Una ventana emergente solicitar‡
que se opte por alguno de los dos
tipos de l’nea de tiempo descritos.

Una vez creadas y dotadas de
contenido, para controlar la eje-
cuci—n de las l’neas del tiempo, es
necesario crear un enlace que las
ejecute cuando se desee que esto
ocurra. Las opciones del menœ
para crear un enlace con una
l’nea del tiempo proporcionan las
opciones ejecutar (play), ejecutar
desde el principio (play from
beginning), rebobinar (rewind) y
pausa (pause).

Modos de Trabajo
Marcando o desmarcando el
modo Lector (Reader mode),
situado en la esquina inferior
derecha del documento activo,
podremos alternar entre los
modos de trabajo de Autor, para
editar contenido y elaborar el
libro, y el modo Lector, destinado
a visualizar el libr o actual. Es
necesario que, en todo momento,
el usuario conozca el modo de
trabajo que est‡ utilizando.

Trabajar c on Libr os
Existen varias formas de iniciar
un nuevo libro Sophie. La forma

tradicional consiste en pulsar sobre Archivo
> Nuevo en el panel principal o pulsar simul-
t‡neamente la combinaci—n de teclas Ctrl-N.
No obstante, podremos crear un nuevo libro
simplemente arrastrando y soltando sobre el
espacio de trabajo una plantilla o un r ecurso
desde las pesta–as del lateral derecho de la
pantalla.

A partir de aqu’ el tr abajo de elaboraci—n
de archivos multimedia es sumamente ‡gil y
sencillo, y consiste b‡sicamente en arrastrar
recursos a las p‡ginas de nuestro libro, mani-
pulando sus propiedades
mediante las pesta–as, tabula-
dores, paletas, halos y huds.
Un acercamiento a la forma de
trabajo de Sophie se puede
observar en la demostraci—n de
utilizaci—n del programa que el
proyecto Sophieincluye en su
p‡gina web y que lleva por
t’tulo Hacer un libro Sophie
(Making a Sophie book) [7].

Se pueden arrastrar y soltar
recursos directamente sobre la
p‡gina del libro. En este caso, el

recurso en cuesti—n se a–adir‡ directamente a
la p‡gina del libro y tambiŽn quedar‡ alma-
cenado en los recursos del libro. Pero tam-
biŽn podremos soltarlo directamente sobre
los tabuladores correspondientes del margen
derecho. De este modo, el recurso estar‡ dis-
ponible para su uso pero no se incorporar‡ a
la p‡gina abierta.

Los recursos que utilicemos no necesaria-
mente deben estar almacenados en el orde-
nador local, es posible establecer enlaces a
recursos de Internet. El menœ File (Archivo)
> Link T o URI permite establecer estos
enlaces conociendo la ruta (URL) del
recurso a utilizar.

Añadir Páginas
Para a–adir p‡ginas al libro abierto, desde la
secci—n Plantillas de p‡gina (page templa-
tes) en la pesta–a estilos(styles), situada en
el margen derecho, arrastraremos la minia-
tura de plantilla hasta la secci—n P‡ginas
(Pages) de la pesta–a p‡ginas (pages) del
margen izquierdo.

Incluir T ext o
En modo de trabajo Editor, la inclusi—n de
un fragmento de texto en las p‡ginas de
Sophie consiste en arrastrar sobre una
p‡gina un marco de texto, redimensionarlo
con el bot—n correspondiente del halo del
objeto y comenzar a escribir tras pulsar
sobre el interior del marco. Como es habi-
tual, se pueden utilizar las rutinas de copiar,
cortar y pegar mediante las combinaciones
de teclas Ctrl-C, Ctrl-Xy Ctrl-V.

Flujo de T ext o
Al insertar marcos de texto en un libr o
Sophieel texto fluir‡, por defecto, de un
marco a otro. Es decir, si se insertan varios
marcos y se comienza a escribir en el pri-
mero, el texto saltar‡ al siguiente una vez se
complete el espacio disponible en el ante-
rior y as’ sucesivamente, asumiendo que se

encuentran conectados como
marcos de texto continuos.
Para evitar que los marcos de
texto estŽn conectados y fun-
cionen como marcos de texto
independientes se deber‡ arras-
trar y soltar hasta la p‡gina del
libro manteniendo pulsada
simult‡neamente la tecla Alt .
De este modo conseguiremos
que el flujo de texto en los mar-
cos insertados de este modo se
mantenga de forma indepen-
diente.
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Figur a 4 : Pest a-

ñas de r ecur sos.

Figur a 5: HUD.
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wledge Iniciative) [8] basada en la iniciativa
Open Courseware del MIT, que facilita y sim-
plifica los mŽtodos para ensamblar, distribuir
y acceder a recursos educativos tecnol—gicos.
Los activos OKIse almacenan en repositorios,
colecciones de archivos multimedia, a los
que se puede acceder mediante el navegador
OKIde Sophie. Estos recursos se pueden a–a-
dir al libr o mediante el procedimiento de
arrastrar y soltar. Para navegar hasta un repo-
sitorio OKIes necesario activar la pesta–a OKI
situada en el margen derecho, introducir una
direcci—n OKIen el campo ÒservidorÓ y pul-
sar Enter. Se puede encontrar un repositorio
OKI en el proyecto OKI-Sophie[9]. Una vez
conectados al Servidor OKI, en la secci—n
assets, se mostrar‡ el ‡rbol del repositorio,
permitiendo expandir cada nodo y mostrar
sus activos. Las secciones Previewy Metapre-
sentar‡n, respectivamente, una miniatur a y
detalles del asset seleccionado.

Servidor S ophie ( Sophie
Server)
Un Servidor Sophiees una aplicaci—n que se
ejecuta en un servidor y actœa de repositorio
para archivar los libros Sophie. Si se tiene
acceso a un Servidor Sophiese podr‡n leer y
editar libros que se encuentren en Žl. Del
mismo modo, podremos a–adir nuestros
libros para compartirlos con otros. Para abrir
el Servidor Sophiepulsaremos sobre la pes-
ta–a Servers del lateral derecho y, en el tabu-
lador Books, seleccionaremos Add a Server to,
o bien, desde la barra de menœs File > A dd
Server. En ambos casos, se desplegar‡ la ven-
tana Add Serverpara cumplimentar la URL
del servidor [10].

Adem‡s de repositorio de libros, el Servidor
Sophiese podr‡ utilizar para tomar contenido
de los libros Sophieque se encuentren en la
red y reutilizarlos para elaborar otros libros.

Enlaces (Link s)
Para crear un enlace en un texto o cualquier
objeto de un libro deberemos seleccionarlo y
pulsar el bot—n enlacedel halo del texto selec-
cionado. La ventana para configurar el enlace
consta de tres secciones: la parte superior,
que permite seleccionar el tipo de evento que

activar‡ el enlace, la zona intermedia, desti-
nada a seleccionar el tipo de acci—n, y la zona
inferior, cuyo contenido cambia dependiendo
del tipo de enlace seleccionado.

El bot—n + despliega ventanas adicionales
que permiten realizar enlaces m‡s complejos.
Un mismo objeto puede contener distintos
tipos de enlace segœn el tipo de evento que
los genere.

Coment ario s (Comment s)
Los marcos de comentarios est‡n destinados
a recoger los comentarios a–adidos al texto
por los lectores. Al tr atarse de un recurso
compartido, es l—gico pensar que requiera
que el usuario estŽ conectado a un Servidor
Sophiedesde donde se descarguen de forma
autom‡tica al abrir el libr o o la p‡gina que los
alberga. Cuando un lector a–ade un comen-
tario al texto su contenido se actualiza en el
servidor y queda disponible como parte inte-
grante del libro. Para a–adir una ventana de
comentarios a un libro bastar‡ con arrastrar y
soltar el recurso componentque se encuentra
en la secci—n Components de la pesta–a
library, situada en el margen derecho. Apare-
cer‡ un peque–o cuadro de comentarios
mostrando en su parte superior el texto Write
Comment(escribir comentario) y, en su mar-
gen derecho, una barra de desplazamiento.
El marco de comentarios se puede resituar y
redimensionar como cualquier otro objeto de
Sophie. Para a–adir un comentario de texto
bastar‡ con pulsar sobre el marco para que
aparezca la ventana correspondiente en la
que se solicita el nombre del autor y el conte-
nido del comentario. El bot—n Commit actua-
liza el contenido del comentario en el Servi-
dor Sophie.

Not as (Stickie s)
Los stickiesson peque–as ventanas con notas
estilo post-it que se pueden a–adir a los
libros. Para crear una nota nueva pulsaremos
sobre la pesta–a tools, situada en el margen
derecho, y seleccionaremos la opci—n new
sticky de la secci—n Stickies. Se incorporar‡ al
libro activo una nota en forma de peque–a
ventana a la que podremos incorporarle texto
y cambiar el color de fondo. El peque–o cua-
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Mediante la opci—n Edit > toggle flow con-
nectionsse mostrar‡n las l’neas de flujo de
los marcos de texto facilitando su modifica-
ci—n.

Buscador de Text o
Como auxiliar de dise–o lectura, Sophie
incluye un buscador de texto. La bœsqueda se
puede realizar de dos formas: mediante la
barra de bœsqueda r‡pida situada en la parte
inferior izquier da (quick search) del libr o
abierto o utilizando la secci—n Bœsqueda
(Searching) de la pesta–a herramientas
(tools), en el margen izquierdo de la pantalla.
En ambos casos se efectuar‡ la bœsqueda del
tŽrmino introducido a partir del punto de
inserci—n. Si la bœsqueda se realiza utilizando
la secci—n Bœsquedade la pesta–a herramien-
tas, se mostrar‡n todas las entradas del tŽr-
mino intr oducido, permitiendo desplazarse
hasta ellas pulsando en cada entrada.

Corr ector de Or tografía
(Spellcheck er)
El corrector de ortograf’a est‡ disponible œni-
camente para lengua inglesa y permite com-
probar las palabras mal escritas a partir del
punto de inserci—n.

Objetos remotos
Una de las caracter’sticas de Sophiees su
capacidad para trabajar con objetos remotos.
Los objetos remotos son recursos que no resi-
den en el equipo desde los que se ejecutan ni
se guardan como parte integrante de los
libros Sophie, sino que se alojan en Servidores
Sophieal que se enlazan desde los libros.
Para utilizar objetos r emotos necesitamos
conocer su URL enlaz‡ndolos mediante el
comando File > Link to URL . El objeto
remoto se incorporar‡ a la pesta–a corres-
pondiente y estar‡ disponible para su uso.
Pero adem‡s, Sophiecuenta con dos impor-
tantes recursos: los activos OKIy los Servido-
res Sophie.

Objetos OKI ( Assets OKI)
Los activos OKI son recursos multimedia
(im‡genes, audio, v’deo) que cumplen los
est‡ndares de la arquitectura OKI(Open Kno-

Figur a 6: Líne a del tiempo .
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drado situado en su barra de t’tulo da acceso
a una paleta de color en la que bastar‡ con
seleccionar el tono deseado. Como cualquier
otro objeto de Sophie, los stickies se pueden
redimensionar y situar en el lugar deseado.

Marcadores (Highlight ers)
Los marcadores son marcas que se establecen
sobre el texto y que pueden utilizarse como
referencias. El aspecto de una marca de texto
se asemeja a las marcas realizadas con rotula-
dor amarillo sobre textos convencionales. Para
establecer una marca de texto seleccionare-
mos el fragmento del mismo que se desee
aparezca marcado y pulsaremos sobre Edit >
Hihglight Text. El fragmento seleccionado apa-
recer‡ resaltado sobre fondo amarillo y, simul-
t‡neamente, se mostrar‡ en la lista de Marca-
doresde la pesta–a toolssituada en el margen
izquierdo, permitiendo utilizar se como anclas
de navegaci—n al punto y p‡gina en el que se
encuentren.

Bloc de Not as (Not ebook)
El bloc de notas es un libro especial de Sophie
que se activa cada vez que abrimos o creamos
un libr o. Si se observa la secci—n Booksde la
pesta–a Bookssituada en el margen izquierdo
se comprobar‡ que, adem‡s del libro activo,
existe otro con el nombre Sophie
Notebook.spbf. Se trata de un libro en blanco
de 400 x 400 p’xeles que se puede utilizar
como elemento auxiliar para incluir en Žl
recursos que se deseen tener a mano para
a–adir a las p‡ginas del texto principal por el
procedimiento de arrastrar y soltar.

Pestaña Bibliot eca
La pesta–a Biblioteca (Library) contiene blo-
ques de componentes para los libros Sophie:
diferentes clases de marcos en la secci—n Com-
ponentesy una colecci—n de plantillas en la
secci—n Plantillas de Libro (Book Templates).
La secci—n Componentescontiene diferentes
clases de marcos que se pueden usar en un
libro Sophiearrastr‡ndolo hasta el espacio de
trabajo. Existen tres tipos de marcos: de texto
continuo, discontinuo y comentario.

Cuando un marco de texto continuo est‡
lleno de texto se a–ade una nueva p‡gina al
libro en la que continœa el texto que se inserta
en el marco. Si hay dos marcos continuos en
una misma p‡gina, el texto fluye de un marco
a otro, salvo que se pulse la tecla Alt al crear el
segundo.

Cuando un marco sin flujo discontinuo se
llena de texto no se crea una nueva p‡gina, el
resto del texto no aparece en la p‡gina a
menos que se redimensione el marco.

Los cuadros de comentarios permiten a los
lectores a–adir comentarios a un libro, como
en un blog. Usan el Servidor Sophie. De este
modo, cada lector que est‡ leyendo un libro
con marcos de comentarios ver‡ todos los
comentarios a–adidos a ese marco por otros
lectores.

La secci—n Plantillas de Librocontiene todas
las plantillas que vienen con Sophieo que se
han guardado. Las plantillas se pueden arras-
trar hasta el espacio de trabajo, para crear un
nuevo libro que use esa plantilla, o a una
p‡gina, para crear un libro incrustado en la
p‡gina.

Libr os Incrus tados
Hay dos formas de crear libros incrustados,
mediante la inclusi—n de un libro en otro o cre-
ando enlaces entre ellos. En el primer caso, el
libro incrustado forma parte del libro padre.
En cambio, en el caso de los libros enlazados,
el libro padre conserva un v’nculo al libr o
enlazado. El procedimiento para crear un libro
incrustado consiste en crear el libro a incrustar
y guardarlo como plantilla de libr o. Posterior-
mente, abriremos el libro padre y arrastrare-
mos la plantilla de libr o creada sobre una de
sus p‡ginas. El libro basado en esa plantilla
quedar‡ incrustado en el interior de la p‡gina
del libro anfitri—n. En el modelo de libros enla-
zados abriremos ambos libros y arrastraremos
el icono del libro que deseamos incrustar
desde la pesta–a libros hasta la p‡gina del
libro padre.

Pestaña Recursos
Contiene todos los archivos multimedia
importados a Sophiecategorizados en textos,
im‡genes, audio y v’deo. Todos estos recursos
se pueden arrastrar y soltar desde sus seccio-
nes hasta un libro Sophie. Si se arrastran direc-

tamente al espacio de trabajo se crear‡ un
nuevo libro que contiene ese recurso œnica-
mente. La secci—n Meta mostrar‡ las caracte-
r’sticas del recurso seleccionado.

Archivos Sophie
Al guardar un libro Sophiese genera una car-
peta con la extensi—n .spbf (acr—nimo de
SoPhie Book Folder) que contiene el archivo
Sophiecon extensi—n .spb (de SoPhie Book),
el archivo Sophie.spbm, archivo con formato
XML que contiene informaci—n referente a
cuando fue creado el libro, el archivo PkgInfo
(archivo de texto usado por el buscador de
Macintosh para identificar al due–o del
paquete) y los recursos locales utilizados. �
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[1] P‡gina del Proyecto Sophie: http://
www .sophieproject.org

[2] Instituto para el futuro del libro: http://
www .futureofthebook.org

[3] Impara: http://www .impara.de/
index_engl.html

[4] Licencia BSD: http://www .
opensource.org/licenses/bsd-license.
html

[5] OLPC: http://laptop.org/

[6] Descarga de la versi—n alpha: http://
sophieproject.org/download/

[7] Hacer un libro con Sophie en
YouToube: http://youtube.com/
watch?v=Ag59IDi3dgQ

[8] Open Knowledge Iniciative: http://
www .okiproject.org

[9] Repositorio OKI-Sophie: http://oki.
sophieproject.org

[10] Para informaci—n de c—mo instalar
un Servidor Sophie: http://dev .
sophieproject.org

RECURSOS

Figur a 7: Servidor S ophie.
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